3. EFL Teaching Approach & Powerpoint Use

Starter Course: Part 1

Name:

ID:

Class:

1. Learning
1.1 What do you expect from your course?
In pairs, discuss (no writing)

a. Are you good at learning languages? Why or why not?
b. What do you think is the best way to learn a new language? Why?

1.2What sort of Language learner are you?

Please work alone.

Please tick V your answers.

Usually Sometimes Almost Never Don’t Know

a. Did/do you get good results in
grammar tests?

b. Do you have a good memory
for new words?

c. Do you hate making mistakes?

d. In class, do you get annoyed
when the teacher doesn’t correct
your mistakes?

e. Is your pronunciation better
when you read aloud than in a
conversation?

f. Do you wish you had more time
to think before speaking?

g. Do you enjoy being in a class?

h. Do you find it difficult to learn
more than 3 words while
travelling abroad?

i. Do you like to learn new
grammar rules, words, etc. by
heart?
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1.3Why do you need or want to learn English?

Please work alone.

What is your Skills needed
purpose?
Situation Vocabulary | Grammar | Listening Speaking Reading Writing

1.4How much do you know/can you do already?
Please work alone.

1 =What do I want? (my goal)
5 = Furthest point from my goal.

Please one number in each column.

Vocabulary Grammar Listening Speaking Reading Writing
1 1 1 1 1 1
2 2 2 2 2 2
3 3 3 3 3 3
4 4 4 4 4 4
5 5 5 5 5 5

1.5What are your priorities?
Please work alone.

1 = highest priority
6 = lowest priority

Skill Priority Rating
Vocabulary
Grammar
Listening
Speaking
Reading
Writing
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1.6 What resources can you access to reach your goals?

Please work alone.

a. How many of the following resources can you use, either in

KMU or outside? Tick V the ones that are available to you.

__Self- access center
___Listening/video/pc room
___DVD player

___Video Camera
___MP3recording device
___Computer

___Library

___English Language Radio
___English Language TV/Movies
____English Language Bookshops /Stores
___English Language Clubs

1.7How much time do you have to learn English?

Please work alone.

a. Try to calculate the approximate amount of time you spend

doing the following things in a typical day:

Activity

Time (approx.)

Sleeping

Getting up (shower, dress...)
Preparing for and eating meals
Short breaks (snacks, coffee, etc.)
Your routine time in work/at school
Travel to and from work/school

Homework for school/work

Total time

How much time does this give you for learning English in a typical day?

Is the time available more or less than you expected?

More / Less

If less, are there any activities you could give up or spend less time

doing?

Yes / No

b. How is the amount of time available to you going to affect your

language learning?
c. Areyou being realistic about what you can achieve?
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1.8How do you organize your time?
Open class discussion
a. Do you have time to review your language learning?

Note: It is important in our class to review what you have
learned 3 times a day.

Morning = 3 minutes
After class = 3 minutes (10 minutes after class has ended)
Evening = 3 minutes

Please take a look at the example Memory Charts below.

1 day 2 days Time

Figure 1

1st review

2
(after 10 mins) - 24 hours =1 week = 1 month if necessary

nd review 3rd review  4th review Further review
<
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1.9How motivated are you?

Open Class Discussion

a. How motivated do you feel now? Why?
b. What things might affect your motivation during the semester?

Motivation Chart

Please work alone.

High Motivation

Low motivation

M|IA|E M|A|E|M|A|E|M]|A]JE A
Monday Tuesday | Wednesday | Thursday Friday
Day Why do you feel motivated or not on this day/time of day?

Monday

Tuesday

Wednesday

Thursday

Friday
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Starter Course: Part 2

A. SKkills
1. Speaking
2. Vocabulary & Phrases
3. Listening
4.  Grammar
5. Writing
6. Reading

B. Speaking Pages

1. Speaking Page 1
2. Speaking Page 2

0

. Review Page

o

. Interaction

1. An example of how 2 Native English Speakers converse in English
2. Conversation Analysis Codes
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A. SKills
1. Speaking

What do you want to improve?

Accuracy — getting your vocabulary, grammar, pronunciation, styles perfect.

Fluency — getting your opinions across, speaking without fear and thought.

What can you use to improve your Speaking?

Dictionary
An MP3/cassette friend

Conversation Club
MP3 recorder

Practice as much as possible
Approach foreigners
Telephone / Skype

Just a minute!

Come to my Office

Live mochawww.livemocha.com

English Centralwww.englishcentral.com

SECNCRCONCRCNCNGRCONCNCNC)

How can you improve your Speaking?

A. Self Assessment Chart

Find poetry; plays, read aloud to practice pronunciation, rhythm, stress.

Date Activity/Situation Points to Assess Assessment

Tuesday March 6™ | Speaking on Topic | Vocabulary, Not great, need

2012 - Travel Grammar more words & to
study the Future

B. Self Short-Term Aims Chart

What? How? When? How long?

Done?

Vocabulary Research Thursday 30 mins
Future tenses online for both | March 8™ 2012

Yes

C. Then repeat Self Assessment Chart.
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2. Vocabulary& Phrases

How to Write in your Notebook (C1 & C2)

Voeabulary Chapter 1 ?jga,g}ef‘

S | Speech

, ols To elﬂed’ 'm an?z(. ing a "h"‘/"“ eW'(‘

,,,,,l,(,,a{’e V. ana "1/('/?'4? san((lmy [MM( ?wafM{f fa ]M’\(w m&“‘(
it bappérs) Lemuse (r(.J:o( hary fo.

Word Form | Pronunciation | Definition J [ Tatsof | Synomm J Transiation | Drawing

Phrasc/Idiom Chapter | Disester

[ Phraselidiom “Definiton Sentence T ummwm'u:‘@\m,‘ Translation 1 B P;\“mi:;‘r
| to fafl ia o Abter the l\e‘vy rain, - buildngs - tollepse
Ca in | _ collepse He rool caved ia. ‘(:{‘" "‘“"Il‘ Al o
[rw() ‘ A'slf#ﬂ Y J

How to Practice your Vocabulary at home:

@ Using single sided cards — 10 card memory game, head game, matching game, eyes
shut game, tic/tac game,

Using two sided cards
Grouping words
Making word networks
Using word bags

Using word chains

CECGECRCORCORC)

Real life situation

How can you improve your Vocabulary?

A. Self Assessment Chart

Date Activity/Situation | Points to Assess Assessment
Tuesday March 6™ | Vocab Test - 20 Travel Words Not great, need
2012 Travel more words

B. Self Short-Term Aims Chart

What? How? When? How long? Done?
Vocabulary Word Chain Starting 1 Week Yes
Thursday 8"
March

C. Then repeat Self Assessment Chart.
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3. Listening

Why? Type? Who? Topic? Situation?
To improve Online — MP3 | Jess- female Men and A dialogue
listening to www.elllo.org | Tom- Male Beauty

English #982 Both British

Accents

What can you use to improve your Listening?

@ Read articles before listening, (collect articles from newspapers, magazines on same
or similar topics)

@ Read reviews of movies, TV programs in English or your language, before listening
or watching.

Email with MP3 or have a cassette ‘pen friend”

A listening club

Activity books with listening

ONGNON®)

Record conversation with others, (listen to it after and see what you didn’t
understand and analyze why)

@ DVD with subtitles (off/on?)

Podcasts, audio books... http://www.teflsites.com/

How can you improve your Listening?

A. Self Assessment Chart

Date Activity/Situation | Points to Assess Assessment
Wednesday March | Elllo #982 British Accent Not great, need
7" 2012 more listenings

B. Self Short-Term Aims Chart

What? How? When? How long? Done?
British Accents | Elllo # 981, Thursday 8™ 45 mins Yes
979 March

C. Then repeat Self Assessment Chart.
Some Tips for Listening & Speaking:

Not so Important Information = STRUCTURE words = articles, conjunctions, Fast,
short pronunciation

Important Information = CONTENT words = nouns, main verbs, adverbs, adjectives,
question words (their stressed syllable is usually longer)

Most Important Information = FOCUS words = usually the last CONTENT word in a
sentence or clause (their stressed syllable is usually long with a higher pitch)
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4. Grammar

Grammar Point

Past Simple

Rule

S + verb (ed)
S+ verb (irregular past)

We use the Simple Past to talk
about past actions that are finished
and have no connection with the
present.

We also use it to show sequences of
past events when telling a story

I saw a great movie last night.

I went to the movie theatre last night. [
watched Hangover 2. It wasn't as
funny as the 15t one.

What can you use to improve your Grammar?

@

@
did)

®

book)

A Pattern Bank

Discuss Grammar

@
®

How can you improve your Grammar?

A. Self Assessment Chart

Use a grammar book, (with exercises and answers)
Speak with people and record the conversation, (listen to it after and see how you

One Grammar Point a week, (match newspaper/magazine articles to the grammar

Date Activity/Situation | Points to Assess Assessment
Friday March 9™ Grammar in Use Present Perfect Confused with past
2012 Chp 22 p58 Simple simple!!
B. Self Short-Term Aims Chart
What? How? When? How long? Done?
Present Online Saturday 10™ | 20 mins Yes
Perfect www.englishpage.com | March
Simple & Verb Tenses
Past Simple

C. Then repeat Self Assessment Chart.
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5. Writing
Accuracy Style Layout Length Organization
of Ideas
Grammar, Opinion. Paragraph, 250 words, Mind Map
punctuation, | Discursive, essay, letter... | 5,000 words... | Index Cards
word order... | argument...

What can you use to improve your Writing?

Model Bank
Memorize

Keep copies

Write Drafts

©OEPO®O®®HO O

Email/pen friend
Marking scheme

Copy texts in English

Personal Diary

Live mocha www.livemocha.com, http://www.lextutor.ca/

How can you improve your Writing?

A. Self Assessment Chart

Date Activity/Situation | Points to Assess Assessment
Friday March 9™ Paragraph Writing | Order of Paragraph, | Need more definite
2012 - Opinionated Topic Sentence... | examples to

support topic

sentence
B. Self Short-Term Aims Chart
What? How? When? How long? Done?
Research Look at Saturday 10™ 1 hour Yes
support newspapers, March
examples for editorials
my opinion
C. Then repeat Self Assessment Chart.
Some Tips for Writing:
You could try the KWL method:
Topic What you KNOW | What you WANT | What you have
to know LEARNED
Travel in Europe | Shengen More info about After research...
Cheap Airlines cheap trains, Ryanair is
Eurail planes, customs cheapest airline..
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6. Reading
Speed Skimming Scanning Reading for Text
Detail
Slow reading | Getting the Quickly Examining a What type of
or fast general idea reading and reading in reading?
reading of a reading picking out detail, maybe | Newspaper, a
important to answer novel, a text
information exam book, a letter,
questions email, text
etc... message...
@ Collect interesting things to read which interest you personally. Keep a scrapbook of
cartoons, recipes etc. Create your own library of books, articles...
@ Reading comprehension
® Email/pen friend
@ A reading club, exchange books, magazines...
(® Subscribe to English language magazines/newspapers.
® Leveled reading: www.breakingnewsenglish.com

http://news.bbc.co.uk/cbbecnews/default.stm
@ Translations: http://www.dailyenglish.com/

How can you improve your Reading?

A. Self Assessment Chart

Date Activity/Situation Points to Assess Assessment

Friday March 9™ Reading a news Vocabulary, writers | Difficult to

2012 story on point of view understand the
www.bbc.com vocab and need

more information
on background of

story...
B. Self Short-Term Aims Chart
What? How? When? How Done?
long?
Research Online — Saturday 1 hour Yes
more vocab | www.breakingnewsenglish.com | March 10™
connected to | and www.dailyenglish.com 6pm
topic.
Research
background

info online.

C. Then repeat Self Assessment Chart.
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A. Self Assessment Chart

Date

Activity/Situation

Points to Assess

Assessment
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B. Self Short-Term Aims Chart

What? How? When? How long? Done?
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How to Use Microsoft Office PowerPoint
Part 1 of 3: Creating a Presentation

1. Choose between a blank presentation and a template.

When you start a new PowerPoint file, you can either create a blank presentation or a template.
Blank presentations allow you to apply your own style, but this can be a time-consuming process.
Templates can give your presentation a uniform style, but they may not suit your exact needs.

You can edit any aspect of a template, so feel free to choose one that mostly matches your vision
and tweak it as you see fit.

You can apply themes to your project at a later time after you've added content. Click the Design
tab and select a theme. It will be immediately applied to your project. You can either undo it
(Ctrl + Z) or revert to a blank theme if you don't like it.

You can access templates from the File tab. Click New and then browse the available templates.
You can also download additional templates from a variety of resources online.

2. Create your title slide.

Your title is the first thing that your audience will see. It should be easy to read and give a basic
overview about the topic of the presentation. Most presenters will include their or their group's
name on the title as well.

3. Add new slides for content.

Press Ctrl + M for a new slide. A blank slide will be added after the slide you are currently on.
The slide will contain a title box and a text box. You can choose to use these or insert your own
objects using the Insert tab.

e When adding a text box, you can click and drag to make it whatever size you'd like. You
can then adjust this later by grabbing one of the corners with your cursor and then
clicking and dragging again.

e You can click on any text box and start typing to begin adding text to your presentation.
You can format text just as you would in Word, with formatting options available in the
Home tab.



4. Navigate your presentation.

You can use the frame on the left side of the window to quickly scroll through your slides.
Clicking any of them will open that slide so that you can edit it. You can click the Outline tab to
see an outline tree of your presentation. Each slide will be labeled by the slide title.

5. Preview your presentation.

You can get a basic feel for the flow of your presentation at this point by pressing F5 to start the
slide show. Click the mouse to advance the slides. Use the preview slide show to get an idea of
how long the presentation is and how well information flows from one slide to the next.

Part 2 of 3: Jazzing It Up

1. Add transitions between slides.

Once you have some content in your slides, you can start adding some effects to help make it a
bit more interesting for your audience. Select a slide and click the Transitions tab. You will see a
list of the most common transitions. You can also click the arrow at the end of the list to open the
full listing of available transitions.

When you pick a transition, it will affect how that slide appears. For example, adding a transition
to Slide 2 will affect how Slide 1 transitions into Slide 2. You will be able to see a preview in the
slide editing window when you click each transition.

Avoid going crazy with a bunch of different transitions. This can be distracting to the audience
and keeps them from focusing on what's most important: your content.

2. Add backgrounds.

Plain white is boring. If your presentation is standard text on a plain white background, half of
your audience will be asleep before you reach the third slide. Use subtle backgrounds to add a
little visual flair to your project.

Right-click on a blank section of your slide and select "Format Background", or click the Design
tab and the click the arrow icon next to "Background™ on the far right.

Choose your fill type. You can choose a solid color, a gradient fill, a picture background, or a
pattern fill. Selecting each choice will display several options for it, such as fill color, picture
location, gradient settings, and more. Experiment until you find the background that fits your
presentation.



By default, the background will only be applied to your active slide. Click the "Apply to All"
button to apply your background choices to every slide.
Make sure that your text is still easily readable with the background you choose

3. Add images.

Adding pictures, diagrams, and other visual aids can help the audience grasp the ideas of your
presentation and drive your point home. Images break up the monotony of text and help keep the
audience from tuning out.

Click the Insert tab. There will be a large number of options when it comes to inserting objects.
Click the Picture button to insert a picture from a file on your computer. You can click the Photo
Album button to insert an entire album of photos into the slide as well.

Use the Charts button to insert easy-to-read charts that will help the audience understand your
data. Once you choose your Chart type, Excel will open, allowing you to enter in your data or
copy it from an existing spreadsheet.

Use the Shapes button to insert pre-made shapes or dray your own. You can use the shapes to
outline important text or create arrows and other visual indicators.

Avoid drowning your presentation with pictures. If it looks too busy, the audience will have a
hard time parsing your written information.

4. Add links.

You can add links to your slides that will allow you to quickly access websites or email
addresses. This can be especially useful if you are distributing the presentation and want people
to be able to easily view related webpages or send you an email.

To add a link, place your cursor in a text box and then click the Hyperlink button on the Insert
tab. You can choose to link to a file on your computer, a webpage, an email address, or even
another slide in your presentation.

5. Embed video.

You can add video files to your slides. This can be useful for reports or any other video file that
may relate to your presentation. The video file will play when the slide appears.[1]

Click the Video button in the Insert tab. you will be able to browse your computer for video files.
While it's not as straightforward, you can embed YouTube videos as well. See this guide to learn
how.



Part 3 of 3: Making It Memorable

1. Keep the number of slides to a minimum.

Extremely long presentations will bore your audience, even if they are obsessed with your
subject matter. Extraneous slides with little to no content will also make the presentation drag
and wear on the audience's interest. Try to keep your presentation short and sweet, and make sure
you are using the space on each slide to it's maximum potential.

2. Choose a good font size.

Presentations are designed to be read, otherwise it would just be a speech. Make sure that your
audience will be able to easily read what you have written. A 10 point font may look okay when
you're sitting at your computer, but when it's projected on the screen, people may be leaning
forward in their seats straining to read.

On a related note, make sure that your font choice is readable as well. Curvy and extravagant
fonts may look cool, but they'll make your audience just stop caring if they can't read it.

3. Apply a consistent, subtle style.

The best presentations are those that have a consistent, deliberate style. use minimal amounts of
color and stylistic accents to make your presentation stand out without being garish. When in
doubt, use one of the templates for a guide.

4. Triple-check for spelling and grammar errors.

If you misspell a word, you might not notice it, but someone in your audience will be sure to spot
it. Spelling and grammar mistakes will lower your credibility, even subconsciously, so you'll
want to work extra hard to ensure that everything is written clearly and correctly.

Get someone to help you proofread your presentation before you give it. A fresh set of eyes are
much more likely to catch mistakes that you gloss over.

5. Practice! The PowerPoint is only part of your presentation.

The other part is you! Take some time and practice your talking points as well as moving
through the slides. Work on your timing and ensure that each slide accurately sums up your
talking points. Make your own notes or memorize your presentation; reading off of your slides
while you are giving your presentation is a big no-no.



